
Uma Rápida Olhada — Tutorial 1 
Neste capítulo: 
 
■ O que o Crystal Ball faz 
■ Tutorial 1 — Futura Apartments 
■ Aprendendo mais 
 
Este capítulo apresenta o básico que você precisa para entender a simulação de Monte Carlo, inicie o Crystal Ball, examine os 
menus e barra de ferramentas, rode simulações, e feche o Crystal Ball. 

O Tutorial 1 está pronto para rodar de modo que você pode rapidamente ver como o Crystal Ball funciona. Se você trabalha 
regularmente com estatística e técnicas de previsões, isto deveria ser toda a introdução que você precisa antes de rodar suas 
próprias planilhas com o Crystal Ball. 

O próximo capítulo, "Olhando Mais Profundamente — Tutorial 2," ensina mais sobre como definir e rodar simulações e 
interpretar os seus resultados. 

Agora, passe alguns poucos momentos aprendendo como o Crystal Ball pode ajudar você a tomar a melhor decisão sob condições 
de incerteza. 

2.1 - O que o Crystal Ball faz 
Como um usuário de planilha, você sabe que as planilhas têm duas grandes limitações: 

■ Você pode variar uma célula da planilha de cada vez. Como resultado, explorar o intervalo todo dos resultados possíveis é quase 
que impossível; você não pode realisticamente determinar a quantidade de risco que está impactando seu lucro líquido (bottom 
line). 

■ Análises “What-if” sempre resultam em estimar um único ponto que não indica a probabilidade de se atingir qualquer resultado 
particular. Enquanto as estimativas de valor único (single-point estimates) poderiam dizer a você o que é possível, elas não dizem 
a você o que é provável. 

O Crystal Ball supera estas ambas limitações: 

■ Você pode descrever um intervalo de valores possíveis para cada célula incerta na sua planilha. Tudo que você sabe acerca de 
cada hipótese (assumption) é expressado tudo de uma vez. 

Por exemplo, você pode definir sua conta de telefone para os meses futuros com qualquer valor entre $2.500 e $3.500, em vez de 
usar uma estimativa de valor único (single-point estimate) de $3.000. 

O Crystal Ball então usa o intervalo definido numa simulação. 

■ Usando um processo chamado simulação de Monte Carlo, o Crystal Ball mostra os resultados num gráfico de previsão que 
apresenta o intervalo inteiro dos resultados possíveis e a probabilidade de atingir cada um deles. 

Ainda mais, o Crystal Ball fica de olho nos resultados de cada cenário para você. 

Para resumir, o Crystal Ball é uma ferramenta analítica que ajuda os executivos, analistas e outros tomadores de decisões 
realizarem simulações em modelos de planilha. A previsão (forecasts) que resulta destas simulações ajuda quantificarem áreas de 
risco de modo que os tomadores de decisão possam ter tantas informações quanto possíveis para suportarem decisões sábias. 

O processo básico para o uso do Crystal Ball, então, é: 

1. Construir um modelo que reflita um cenário incerto. 

2. Rodar uma simulação dele. 

3. Analisar os resultados. 

A melhor maneira de se entender rapidamente este processo é iniciar o Crystal Ball e trabalhar no primeiro tutorial: a planilha 
Futura Apartments. 

2.2 Tutorial 1 — Futura Apartments 
Neste tutorial, você aprenderá como: 



■ Iniciar o Crystal Ball. 

■ Abrir um modelo exemplo dentro do Crystal Ball. 

■ Usar os menus, barra de ferramentas, e Painel de Controle do Crystal Ball para rodar um modelo exemplo. 

■ Trocar para o modo de simulação Demo para uma olhada mais estreita de como o Crystal Ball funciona. 

■ Fechar o Crystal Ball. 

2.2.1 Start Crystal Ball 
Com o Excel fechado ou aberto: 

1. Escolha iniciar > [Todos] Programas > Crystal Ball > Crystal Ball. 

O Crystal Ball abre e lança o Excel. Se o Excel já estiver aberto, o Crystal Ball abre-se numa nova janela do Excel. 

2.2.1.1 Janela de Saudação Welcome do Crystal Ball 
A primeira vez que você iniciar o Crystal Ball, a janela Welcome aparece, similar à Figura 2–1, seguinte. Dependendo de suas 
características de licença e se você está usando uma versão Trial ou comprada, a janela poderá diferir um pouco desta ilustração. 

Figura 2–1 A janela Welcome do Crystal Ball 

 
Você pode usar a janela Welcome para: 

■ Configurar certas preferências de acordo como você usa o Crystal Ball 

■ Ver os tutoriais ou dicas online 

■ Ver uma lista online dos novos melhoramentos 

■ Feche a janela e comece a usar o Crystal Ball 

■ Mostre a caixa de diálogo Excel File > Open 

■ Mostre o Crystal Ball Examples Guide 

■ Compre o Crystal Ball, se você estiver usando uma versão de avaliação por tempo determinado 

Para uma explicação das configurações “tipo principais aplicações”, clique no hiperlink What Is This?. 

 



2.2.1.2 Menus Crystal Ball 
Quando você carregar o Crystal Ball com o Microsoft Excel, alguns novos menus aparecerão na barra de menus do Excel. 

Figura 2–2 Menus do Crystal Ball no Excel 

 
Estes menus levam você a definir, executar, e analisar as simulações no Crystal Ball. Você pode também usar comandos do menu 
Ajuda do Excel para mostrar a ajuda online, documentação, e modelos exemplos para o Crystal Ball. 

2.2.1.3 A barra de ferramentas do Crystal Ball  
A barra de ferramentas do Crystal Ball fornece acesso instantâneo à maioria dos comandos mais usados comumente. Cada seção 
da barra de ferramentas corresponde a um menu. Quando você mover o cursor sobre um botão da barra de ferramentas, o nome do 
comando aparece. 

 
Note: If you are using Crystal Ball in Excel 2007, você verá uma única guia do Crystal Ball e daí uma faixa de opções em vez de 
uma barra de ferramentas. Para mais informações, ver Apêndice B, "Usando o Crystal Ball no Excel 2007." 
 

Figura 2–3 A barra de ferramentas do Crystal Ball  

 
Para desligar a barra de ferramentas do Crystal Ball para a sessão corrente, escolha View > Toolbars > Crystal Ball. 

Para mais informações acerca do menus e barra de ferramentas, ver Apêndice A, "Toolbar and Menu Commands: Excel 2003 or 
earlier". 

(Se você estiver usando o Excel 2007, ver Apêndice B, "Usando o Crystal Ball no Excel 2007"). 

2.2.2 Abra o modelo exemplo 
Abra a pasta de trabalho Futura Apartments (Futura Apartments.xls) da pasta Examplos do Crystal Ball. 



Você pode encontrar esta pasta escolhendo Ajuda > Crystal Ball > Examples Guide. Você pode também escolher Iniciar > [Todos] 
Programas > Crystal Ball > Examples na barra de tarefas do Windows. 

(No Excel 2007, escolha Resources > Examples Guide no grupo Help). 

Quando você abrir o arquivo Futura Apartments.xls, a pasta de trabalho aparece, como na Figura 2–4. 

Figura 2–4 Pasta de trabalho da Futura Apartments 

 
2.2.2.1 Sobre o modelo 
Todos os modelos exemplos incluídos no Crystal Ball incluem estas duas planilhas: 

■ Uma alça Model com a planilha modelo 

■ Uma alça Description com a informação sobre o modelo 

A alça Description contém informações detalhadas sobre o cenário do modelo e como as fórmulas da planilha são construídas de 
modo que você possa usar cada modelo exemplo como um tutorial. Para uma lista dos modelos incluídos no Crystal Ball, escolha 
Help > Crystal Ball > Examples Guide na barra de menus do Excel ou escolha Iniciar > [Todos] Programas > Crystal Ball > 
Examples e abra o Examples Guide. 

(No Excel 2007, escolha Resources > Examples Guide). 

2.2.2.2 O cenário do modelo Futura Apartments 
Neste exemplo, você é um potencial comprador do complexo Futura Apartments. Você tem pesquisado a situação e criou o 
arquivo Futura Apartments.xls para ajudá-lo a tomar uma decisão sábia. Seu trabalho tem levado você a fazer as seguintes 
hipóteses (assumptions): 

■ $500 por mês é o aluguel existente para aquela área. 

■ O número de unidades alugadas durante qualquer dado mês será algo entre 30 e 40. 

■ Os custos operacionais serão em média ao redor de $15.000 por mês para o complexo inteiro, mas poderá variar ligeiramente de 
mês a mês. 

Baseado nestas hipóteses, você quer saber quão lucrativo o complexo de apartamento será para as várias combinações de unidades 
alugadas e custos operacionais. Isto seria difícil de calcular usando a planilha somente. Tão útil quanto são as planilhas, você não 
pode reduzir as duas últimas hipóteses a valores únicos como exigido pelo formato da planilha. Se você tentar todas as 
combinações, você precisará gastar uma grande quantidade de tempo trabalhando com cenários what-if, entrando com valores 
únicos e registrando os resultados. 

Daí então, você provavelmente ficará com uma montanha de dados em vez do quadro completo de lucro e perdas. 



Com o Crystal Ball, esta espécie de análise é fácil. 

Para este tutorial, a simulação já foi montada para você. Você apenas precisa executá-la usando as configurações default do 
Crystal Ball. 

2.2.3 Executar a simulação 
Para executar a simulação: 

    1. Escolha Run > Start [Simulação]. 

O Crystal Ball executa uma simulação para a situação na pasta Futura Apartments e mostra um gráfico forecast enquanto ele 
calcula os resultados. 

   Por default, a simulação pára automaticamente após ter rodado 1.000 trials. Para modelos maiores, você pode usar o botão 
Stop ou escolher Run > Stop [Simulação] se for necessário parar a simulação antes que todas as trials tiverem rodado. 

Quando a simulação pára, aparece a janela forecast, como na Figura 2–5. Os números variarão ligeiramente a cada vez que a 
simulação é rodada, mas a janela forecast se parecerá semelhante a esta ilustração. 

Figura 2–5 Previsão de lucros/perdas da Futura Apartments 

 
 

Nota: Se a janela forecast desaparecer da janela do Excel durante uma simulação, você pode trazê-la de volta para frente clicando 
o ícone do Crystal Ball na barra de tarefas do Windows. 

No Excel 2007, você pode escolher Analyze > View Charts > Forecast Charts 

 
Cenário Futura Apartments. Cada barra no gráfico representa a chance, ou probabilidade, de ganhar um dado lucro. O amontoado 
de colunas próximo ao centro indica que o nível de lucro mais provável está entre $2.000 e $4.000 por mês. Note que existe 
também uma pequena chance de perder quase $2.000 por mês (a extremidade esquerda do intervalo mostrado) e uma pequena 
chance de lucrar cerca de $7.000. 

Note que a probabilidade, ou certeza, de um valor cair dentro de um intervalo de menos infinito e mais infinito é 100%. Note que 
o canto esquerdo superior do gráfico mostra 1.000 trials, mas o canto direito superior do gráfico mostra 998 displayed. 

Os valores excluídos, se existirem, são chamados outliers. Eles estão incluídos nos cálculos mas não estão incluídos no gráfico 
forecast. 



2.2.4 Determine o lucro 
Agora você pode usar o Crystal Ball para determinar a probabilidade estatística de se fazer lucro: 

1. Selecione o campo de certeza esquerdo na janela forecast. 

2. Digite 0 no campo. 

 
3. Pressione Enter. 

O valor no campo Certainty muda para refletir a probabilidade de ter lucro — alcançando um nível de lucro variando de $0 até 
mais infinito. Esta informação coloca  

Nota: Se a janela forecast desaparecer da janela do Excel durante uma simulação, você pode trazê-la de volta clicando o ícone do 
Crystal Ball na barra de tarefas do Windows. 

No Excel 2007, você pode escolher Analyze > View Charts > Forecast Charts. 

 
Você numa posição muito melhor para decidir se compra o complexo Futura Apartments. 

A Figura 2–6 mostra que a chance de ter lucro é cerca de 90%. 

Figura 2–6 Chance de lucro 

 

2.2.5 Dando uma olhada além das cenas 
Apesar de resultados poderosos aparecerem neste exemplo com virtualmente nenhum esforço, obviamente deve existir alguns 
drivers no processo. O Crystal Ball não pode gerar os mesmos resultados para qualquer planilha típica sem alguma ajuda. 

A chave é usar o Crystal Ball para definir certas células de entrada da planilha como hipóteses (assumptions) e certas células de 
saída de interesse como forecasts. 

Uma vez definidas estas células, o Crystal Ball usa a simulação de Monte Carlo para modelar a complexidade do cenário do 
mundo real. 

Para cada trial de uma simulação, o Crystal Ball repete os três passos seguintes: 

 



 

 

 

2.2.5.1 As células do Crystal Ball no modelo exemplo 
O modelo Futura Apartments tem duas células hipóteses (assumption cells) e uma célula previsão (forecast célula). Elas já foram 
definidas antes de você rodar a simulação: 

■ A célula C5 define a assumption acerca da ocupação — aquelas unidades alugadas a cada mês variarão entre 30 e 40. 

■ A célula C7 define a assumption acerca dos custos operacionais — estes terão média ao redor de $15.000 por mês mas poderá 
variar ligeiramente. 

■ A célula C9 define a simulação forecast (os resultados). Se você destacar a célula C9, você pode ver que ela contém uma fórmula 
que referencia as células C5 e C7. 

Por default, as células assumption são verdes e as células forecast são azuis. Para cada tentativa ( Trial) da simulação, os valores 
dentro destas células mudam quando a planilha for recalculada. 

Para ver este processo de perto, reset o modelo e execute-o novamente no modo single-step. Você pode usar o Painel de Controle 
do Crystal Ball para este procedimento. 

2.2.6 Reset e single-step 
Quando você rodar pela primeira vez a simulação, o Painel de Controle do Crystal Ball aparece. Uma vez tendo aparecido, você 
encontrará conveniente usá-lo para gerenciar as simulações e analisar os resultados. 

 

Nota: Se o Painel de Controle ou quaisquer outras janelas do Crystal Ball desaparecerem do Excel, você pode clicar no ícone do 
Crystal Ball na barra de tarefas do Windows para mostrá-la novamente. 

 
 

1. Para cada célula hipótese (assumption), um número randômico é gerado de acordo 
com o intervalo que você definiu e daí então é colocado na planilha. 

2. A planilha é recalculada. 

3. Um valor é resgatado de cada célula forecast e adicionado ao gráfico na janela 
forecast. 

Este é um processo iterativo que continua até: 

■ A simulação atingir um critério de parada, ou 

■ Você parar a simulação manualmente 

O gráfico forecast final reflete a incerteza combinada das células hipóteses 
(assumption) na saída do modelo. Tendo em mente que a simulação de Monte Carlo 
pode somente aproximar à situação real. Quando você construir seu próprio modelo de 
planilha, você precisa cuidadosamente examinar a natureza do problema e 
continuamente refinar os modelos até eles se aproximarem tanto quanto possível da sua 
situação. 



 

Figura 2–7 O Painel de Controle do Crystal Ball  

 
Para informação acerca dos menus do Painel de Controle do Crystal Ball, ver “The Crystal Ball 
Painel de Controle menubar” no Capítulo 4 do Crystal Ball User Manual. 
■ Para reiniciar a simulação e limpar todos os cálculos anteriores, clique no botãoReset.    
■ Para fazer o single-step pela simulação uma trial de cada vez, clique no botão Single-step . 

Note que os valores nas células assumption e forecast mudam a cada vez que você clicar no botão Single-step. 

2.2.7 Close Crystal Ball 
Este Tutorial 1 completa. Você pode salvá-lo e fechar os modelos Crystal Ball da mesma maneira que qualquer outra pasta Excel. 

Se você quiser, você pode clicar no botão Reset ou escolher Run > Reset [Simulation] para reiniciar  

Seu modelo antes de você fechar o Crystal Ball.    

Para fechar o Crystal Ball, ou: 

■ Clique com o botão direito do mouse no ícone do Crystal Ball na barra de tarefa do Windows taskbar e escolha Close, ou 

■ Feche o Excel. 

2.2.8 Revisão do Tutorial 
Neste tutorial, você: 

■ Abriu o Crystal Ball. 

■ Usou os menus, barra de ferramentas, e Painel de Controle do Crystal Ball para rodar um modelo exemplo. 

■ Observou como as células assumption e forecast do Crystal Ball mudam enquanto executa uma simulação. 

■ Fechou o Crystal Ball. 

2.3 Aprendendo mais 
Para informação background sobre o risco, análise de risco, modelos e simulação de Monte Carlo, ver Capítulo1 do Crystal Ball 
User Manual. 

O Tutorial 2, no próximo capítulo, mostra como definir as células assumption e forecast e dá mais sugestões para analisar os 
resultados. 

 



3 
3Olhando mais Profundamente — Tutorial 2 

Neste capítulo: 

■ Tutorial 2 — Vision Research 

■ Aprendendo mais 

O Tutorial 1, no capítulo anterior, simulou as projeções lucro/perdas dos aluguéis de apartamento e apresentou o básico para 
iniciar o Crystal Ball e usá-lo para executar simulações. 

O Tutorial 2, neste capítulo, dá-lhe uma oportunidade para entrar com dados e montar uma simulação completa para a decisão de 
uma grande despesa corporativa. 

3.1 Tutorial 2 — Vision Research 
Este capítulo contém um tutorial para a planilha Vision Research. Este tutorial fornece uma situação mais realística para levar você 
a examinar as características do Crystal Ball numa profundidade maior. Entretanto, se você se sentir confortável em executar o 
Crystal Ball agora, você pode se referir ao Crystal Ball User Manual para iniciar analisando suas próprias planilhas. 

Quando você trabalhar neste tutorial, não se preocupe em cometer erros. Retornar é tão fácil quanto reverter e repetir os passos. Se 
você precisar de ajuda adicional, veja a ajuda online do Crystal Ball. 

Neste tutorial, você examinará ou aprenderá como: 

■ Iniciar o Crystal Ball 

■ Abrir o modelo exemplo 

■ Examinar o cenário Vision Research 

■ Definir assumptions 

■ Definir forecasts 

■ Executar a simulação 

■ Interpretar os resultados 

■ Fechar o Crystal Ball 

3.1.1 Iniciar o Crystal Ball 
Se o Crystal Ball não estiver iniciado ainda, siga as instruções da Seção 2.2.1, "Iniciar o Crystal Ball". 

3.1.2 Abra o modelo exemplo 
Abra o arquivo Vision Research (Vision Research.xls) da pasta Crystal Ball Examples. 

Você pode encontrar esta pasta escolhendo Help > Crystal Ball > Examples Guide. Você pode também escolher Start > 
Programs > Crystal Ball > Examples na barra de tarefas do Windows. 

(No Excel 2007, escolha Resources > Examples Guide). 

O arquivo Vision Research para o projeto ClearView aparece, como na Figura 3–1. 

 

 

 

 

 

 



Figura 3–1 Pasta do projeto ClearView da Vision Research 

 
Esta planilha modela o problema que a Vision Research está tentando resolver. 

3.1.3 Exame do cenário da Vision Research 
A planilha Vision Research modela uma situação de negócio cheia de incerteza. A Vision Research completou o desenvolvimento 
preliminar de uma nova droga, codificada como ClearView, que corrige miopia. Este novo produto revolucionário poderá ser 
completamente desenvolvido e testado a tempo de ser liberado no próximo ano se a FDA aprovar o produto. Embora a droga 
funciona bem para alguns pacientes, a taxa de sucesso completo é marginal, e a Vision Research está incerta se a FDA aprovará o 
produto. 

Você começa sua análise definindo células hipóteses (assumption) para suportar este cenário. 

3.1.4 Define assumptions 
No Crystal Ball, você define uma assumption para uma célula de valor escolhendo uma distribuição de probabilidade que descreva 
a incerteza dos dados na célula. Para efetuar isto, você escolhe entre os tipos de distribuição na Distribution Gallery (ver Figura 3–
2 na página 3-4). 

Como você sabe qual o tipo de distribuição escolher? Esta porção do tutorial o ajudará a entender como escolher um tipo de 
distribuição baseado na resposta que você está procurando. Nos exercícios seguintes, você seleciona as células assumption na 
planilha Vision Research e escolhe a distribuição de probabilidade que descreve mais precisamente as incertezas do projeto 
ClearView. Para maiores informações acerca de como escolher distribuições, ver Apêndice D, "Escolhendo uma distribuição" 
neste Guias e o Apêndice A do Crystal Ball User Manual. 

Você precisa definir ou examinar estas assumptions: 

■ Assumption Custo de Testes: distribuição uniforme 

■ Assumption Custo de Marketing: distribuição triangular 

■ Assumption Pacientes Curados: distribuição binomial 



■ Assumption Taxa de Crescimento: distribuição customizada 

■ Assumption Penetração no Mercado: distribuição normal 

3.1.4.1 Testing Costs assumption: distribuição uniforme 
Até agora, a Vision Research gastou $10.000.000 desenvolvendo o ClearView e espera gastar um adicional de $3.000.000 a 
$5.000.000 para testá-lo baseado nos custos dos testes anteriores. Para esta variável, “custos de testes”, a Vision Research pensa 
que qualquer valor entre $3.000.000 e $5.000.000 tenha uma chance igual de ser o custo real do teste. Usando o Crystal Ball, a 
Vision Research escolhe a distribuição uniforme para descrever os custos de teste. A distribuição uniforme descreve uma situação 
onde todos os valores entre o mínimo e o máximo são igualmente prováveis de ocorrerem, assim esta distribuição descreve melhor 
as estimativas boas para o custo de teste do ClearView. 

Uma vez escolhida o tipo correto de distribuição, você está pronto para definir a célula assumption. 

Para definir a célula assumption para os custos de testes: 

1. Clique na célula C5. 

2. Escolha Define > Define Assumption. 

Devido a uma assumption não ter sido ainda definida na célula C5, a caixa de diálogo Distribution Gallery aparece como 
mostrado na Figura 3–2. 

Figura 3–2 A caixa de diálogo do Distribution Gallery 

 
Por default, as distribuições Básicas aparecem. Estas são as seis distribuições contínuas e discretas mais frequentemente usadas. 
Quando você clicar numa distribuição para escolhê-la, uma informação sobre aquela distribuição aparece no fundo da Distribution 
Gallery. 

3. Clique na distribuição Uniform. 

4. Clique OK. 

A caixa de diálogo Uniform Distribution aparece. 

 

Nota: No Excel 2007, se você clicar na metade superior do ícone Define Assumption ou se a assumption já tiver sido definida, a 
Distribution Gallery aparece. 

Se você clicar a metade inferior do ícone Define Assumption, uma lista de todas as distribuições, Básicas ou Favoritas, aparece, 
dependendo da categoria ativa na Distribution Gallery 

3. Clique na distribuição Uniform. 

4. Clique OK. 

A caixa de diálogo Uniform Distribution aparece. 

Barra de Menu

Painel Categoria com 
as pastas Categoria 

Painel Distribuição 

Painel Descrição 



Figura 3–3 Uniform distribuition para C5 

 
Como a célula C5 já tem um texto à esquerda dela na planilha, aquele texto aparece no campo Assumption Name. Use este nome, 
ao invés de digitar um novo. Também, note que o Crystal Ball determina valores default aos parâmetros da distribuição, Mínimo e 
Máximo. 

A Vision Research espera gastar um mínimo de $3.000.000 e um máximo de $5.000.000 nos testes. Use estes valores no lugar dos 
defaults para especificar os parâmetros da distribuição uniforme no Crystal Ball, como descrito nos seguintes passos: 

5. Digite 3 no campo Minimum (lembre-se que os números na planilha representam milhões de dólares). 

Isto representa $3.000.000, a quantia mínimo que a Vision Research estima para custos de testes. 

6. Pressione Tab. 

7. Digite 5 no campo Maximum. 

Isto representa $5.000.000, a máxima estimativa para os custos de teste. 

8. Clique Enter. 

A distribuição muda para refletir os valores que você entrou, como mostrado na Figura 3–4. 

Figura 3–4 Valores da distribuição mudados 
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Com os valores dos Passos 5 e 7 entrados corretamente, sua distribuição fica como a Figura 3–4. Mais tarde, quando você rodar a 
simulação, o Crystal Ball gerará valores randômicos para a célula C5 que estão igualmente espalhados entre 3 e 5 milhões de 
dólares. 

9. Clique em OK para retornar à planilha. 

A célula assumption está agora verde. 

3.1.4.2 Assumption Custos de Marketing: distribuição triangular 
A Vision Research planeja gastar uma quantia considerável em marketing do ClearView se a FDA aprová-lo. Eles esperam 
requerer os serviços de uma grande força de venda e promover uma extensiva campanha de propaganda para educar o público 
sobre este novo excitante produto. Incluindo comissões de vendas e custos de propaganda, a Vision Research espera gastar entre 
$12.000.000 e $18.000.000, com uma quantia mais provável de $16.000.000. 

A Vision Research escolheu a distribuição triangular para descrever os custos de marketing porque a distribuição triangular 
descreve uma situação onde você pode estimar o mínimo, o máximo, e o mais provável valor a ocorrer. Esta assumption já foi 
definida para você. 

Para examinar a célula assumption para os custos de marketing: 

1. Clique célula C6. 

2. Escolha Define > Define Assumption.           

A caixa de diálogo Triangular Distribution aparece para a célula C6.      

Figura 3–5 Triangular distribuição para célula C6 

 
A distribuição triangular tem três parâmetros — Minimum, Likeliest, e Maximum: 

■ Minimum está configurado para $12.000.000, a quantia mínima que a Vision Research estima para custos de marketing. 

■ Likeliest está configurado para $16.000.000, a quantia mais provável para custos de marketing. 

■ Maximum está configurado para $18.000.000, a estimativa máxima para os custos de marketing. 

Quando você rodar a simulação, o Crystal Ball gerará valores randômicos que cairão ao redor de 16, com muito poucos valores 
próximos a 12 e 18. 

3. Clique OK para retornar à planilha. 

 



3.1.4.3 Assumptions Pacientes Curados: distribuição binomial 
Antes da FDA aprovar o ClearView, a Vision Research deve conduzir um teste controlado numa amostra de 100 pacientes por um 
ano. A Vision Research espera que a FDA concorde com a aprovação se a ClearView corrigir completamente a miopia de 20 ou 
mais destes pacientes sem quaisquer efeitos colaterais significativos. Em outras palavras, 20% ou mais dos pacientes testados 
devem mostrar a visão corrigida depois de tomar o ClearView por um ano. 

A Vision Research está muito encorajada nos seus testes preliminares, os quais mostram uma taxa de sucesso de cerca 25%. 

Para esta variável, “pacientes curados,” a Vision Research sabe que somente seus testes preliminares mostram uma taxa de cura de 
25%. A ClearView se adequará aos padrões da FDA? Usando o Crystal Ball, a Vision Research escolheu a distribuição binomial 
para descrever as incertezas nesta situação porque a distribuição binomial descreve o número de sucesso randômico (25) num 
número de tentativas fixas (100). 

Esta assumption já foi definida. Para examinar a célula assumption para os pacientes curados, use os passos seguintes. 

1. Clique na célula C10. 

2. Escolha Define > Define Assumption.  

A caixa de diálogo Binomial Distribution aparece como mostrado na Figura 3–6.    

Figura 3–6 A caixa de diálogo da Binomial Distribution 

 
A distribuição binomial tem dois parâmetros: Probability e Trials. Devido a Vision Research ter experimentado uma taxa de 
sucesso de 25% durante os testes preliminares, o parâmetro Probability é configurado para 0.25 para mostrar a probabilidade de 
sucesso. 
 

Note: Você pode expressar as probabilidades ou como números decimais entre 0 e 1, tal como 0.03, ou como números inteiros 
seguidos pelo sinal de porcentagem, tal como 3%. 
 

Devido a FDA esperar a Vision Research testar 100 pessoas, o parâmetro Trials é configurado para 100. Quando você rodar a 
simulação, o Crystal Ball gerará inteiros randômicos entre 0 e 100, simulando o número de pacientes que serão curados no teste 
FDA. 

3. Clique OK para retornar a planilha. 

 
 



3.1.4.4 A assumption Taxa de Crescimento: distribuição customizada 
A Vision Research determinou que a miopia atinge aproximadamente 40.000.000 pessoas nos United States, e um adicional de 0% 
a 5% destas pessoas desenvolverão esta condição de miopia durante o ano em que a ClearView é testada. 

Entretanto, o departamento de marketing aprendeu que uma chance de 25% existe de que um produto concorrente será lançado no 
mercado em breve. Este produto diminuirá o mercado potencial da ClearView em 5% a 15%. 

Esta variável, “taxa de crescimento de miopia”, não pode ser descrita por qualquer das distribuições padrões de probabilidade. 
Como as incertezas nesta situação exigem uma abordagem única, a Vision Research escolheu a distribuição customizada do 
Crystal Ball para definir a taxa de crescimento. Na maioria das vezes, a distribuição customizada é usada para descrever situações 
que os outros tipos de distribuições não podem. 

O método para especificar os parâmetros na distribuição customizada é bem diferente dos outros tipos de distribuição, então siga 
as direções cuidadosamente. Se você cometer um erro, clique na Gallery para retornar à galeria de distribuições, daí então inicie 
novamente no passo 4. 

Use a distribuição customizada para fazer o gráfico do aumento e diminuição potencial do mercado da ClearView. 

Para definir a célula assumption para a taxa de crescimento de miopia: 

1. Clique na célula C15. 

2. Escolha Define > Define Assumption.  

(No Excel 2007, clique na metade superior do ícone Define Assumption). 

A caixa de diálogo Distribution Gallery aparece. 

3. Clique All à esquerda da Distribution Gallery para mostrar todas as distribuições enviadas com o Crystal Ball.    

Figura 3–7 A categoria  All da Distribution Gallery 

 
A categoria All mostra distribuições contínuas no topo seguido por distribuições discretas. Você deverá usar as distribuições 
discretas, por exemplo, para expressar um intervalo de valores em total de dólares. 

4. Role para baixo até o final da Distribution Gallery e clique na distribuição Custom. 

5. Clique OK. 

A caixa de diálogo da Custom Distribution aparece. 

Note na Figura 3–8 que a área do gráfico permanece vazia até você especificar o tipo de Parâmetros e entrar com os valores para a 
distribuição. 

Figura 3–8 A  caixa de diálogo da Custom Distribution 



 
Por default, a caixa de diálogo da Custom Distribution está configurada para aceitar valores únicos com probabilidades 
diferentes, ou ponderada. Existem dois parâmetros: Value e Probability. 

Você sabe que estará trabalhando com dois intervalos de distribuição: um mostrando o crescimento de miopia e outro mostrando 
os efeitos da concorrência. Ambos os intervalos são contínuos. 

6. Abra o menu Parameters. 

Figura 3–9 O menu Parameters da distribuição Custom 

 
7. Escolha Continuous Ranges no menu Parameters. 

A caixa de diálogo Custom Distribution tem agora três parâmetros: Minimum, Maximum e Probability. 

 

 

 

 

 

 

 

 

A área fica vazia 
até você entrar 
com os valores



Figura 3–10 A caixa de diálogo de configuração da Custom distribuition para  continuous distributions 

 
8. Entre com o primeiro intervalo de valores para mostrar o crescimento de miopia com baixa distribuição de probabilidade dos 
efeitos da concorrência: 

a. Digite 0% no campo Minimum. 

Isto representa um crescimento 0% no potencial de mercado. 

b. Digite 5% no campo Maximum. 

Isto representa um crescimento de 5% no potencial de mercado. 

c. Digite 75% ou .75 no campo Probability. 

Isto representa a chance de 75% daqueles concorrentes da Vision Research não entrarem no mercado e reduzirem a fatia de 
mercado da Vision Research. 

d. Clique Enter. 

A distribuição uniforme para o range 0% até 5% aparece. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Figura 3–11 Intervalo Uniform distribuição 

 
9. Agora, entre com um segundo intervalo de valores para mostrar os efeitos da concorrência: 

a. Digite -15% no campo Minimum. 

Isto representa um decréscimo de 15% no potencial de mercado. 

b. Digite -5% no campo Maximum. 

Isto representa um decréscimo de 5% no potencial de mercado. 

c. Digite 25% no campo Probability. 

Isto representa a chance de 25% daqueles concorrentes da Vision Research entrarem no mercado e diminuírem a fatia da Vision 
Research em 5% até 15%. 

d. Clique Enter. 

A distribuição uniforme para o intervalo de -15% a -5% aparece. Ambos os intervalos agora aparecem na caixa de diálogo da 
Custom Distribution. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 3–12 Customized distribuição uniforme 
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Note que a área do segundo intervalo é também igual a sua distribuição de probabilidade: 2.5 x 10% = 25%. 

10. Clique OK para retornar à planilha. 

Quando você rodar a simulação, o Crystal Ball gerará valores randômicos dentro dos dois intervalos de acordo com as 
probabilidades que você especificou. 

3.1.4.5 A assumption Penetração de Mercado: distribuição normal 
O departamento de marketing estima que a eventual fatia do mercado total da Vision Research para o produto será distribuída 
normalmente ao redor do valor médio de 8% com um desvio padrão de 2%. “Distribuído Normalmente” significa que a Vision 
Research espera ver a familiar curva de forma de sino com cerca 68% de todos os valores possíveis para penetração de mercado 
caindo entre um desvio padrão abaixo da média e um desvio padrão acima da média, ou entre 6% e 10%. 

O baixo valor da média de 8% é uma estimativa conservadora que leva em conta os efeitos colaterais da droga que não foram 
notados durante os testes preliminares. Ainda mais, o departamento de marketing estima um mercado mínimo de 5%, dado ao 
interesse mostrado no produto durante os testes preliminares. 

A Vision Research escolheu a distribuição normal para descrever a variável “penetração de mercado”. 

Para definir a célula assumption para a penetração de mercado: 

1. Clique na célula C19. 

2. Escolha Define > Define Assumption.  

(No Excel 2007, clique na metade superior do ícone Define Assumption). 

A caixa de diálogo Distribution Gallery aparece. 

3. Clique na distribuição normal. 

Para achar a distribuição normal, você pode ou rolar para o topo da categoria All ou clicar Basic para imediatamente mostrar a 
distribuição normal 

4. Clique OK. 

A caixa de diálogo da Normal Distribution aparece.    
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Figura 3–13 Distribuição Normal para a célula C19 

 
5. Especifique agora os parâmetros para a distribuição normal: a média e o desvio padrão. 

a. Se o campo Mean não contém 8.00%, digite 8% no campo Mean. 

Isto representa uma média estimada para a penetração de mercado de 8%. 

b. Digite 2% no campo Std. Dev.. 

Isto representa um desvio- padrão da média estimado em 2%. 

6. Clique Enter. 

A distribuição normal adapta-se para ajustar a areado gráfico, assim a forma da distribuição não muda. Entretanto, a escala de 
porcentagens no eixo do gráfico muda como mostrado na Figura 3–14. 

Figura 3–14 A caixa de diálogo  Normal Distribution com  parâmetros alterados 

 



7. Clique no botão More para mostrar campos adicionais acima dos parâmetros.    

Figura 3–15 Assumption truncation fields 

 
Estes campos, marcados por setas cinzas, mostram os valores mínimo e máximo do intervalo de assumption. Se os valores são 
entrados neles, eles cortam ou truncam o intervalo. Estes campos são então chamados de truncation mínimo e máximo. 

8. Digite 5% no campo truncation à esquerda, mínimo. 

Isto representa 5%, o mínimo mercado para o produto. 

9. Clique Enter. 

A distribuição muda para refletir os valores que você entrou. 

Figura 3–16 Distribuição mudada pelos valores truncados 

 
Quando você rodar a simulação, o Crystal Ball gerará valores randômicos que seguem uma distribuição normal ao redor do valor 
médio de 8%, e com nenhum  dos valores gerados abaixo de 5% do limite mínimo. 

10. Clique OK para retornar à planilha. 

3.1.5 Define forecasts 

Agora que você definiu as células assumption no seu modelo, você está pronto para definir as células forecast. As células forecast 
contém fórmulas que se referem a uma ou mais células assumption. 

O presidente da Vision Research gostaria de conhecer ambas a probabilidade de obter lucro sobre o produto e os lucros mais 
prováveis, a despeito do custo. Estes forecasts aparecem no lucro bruto (célula C21) e lucro líquido (célula C23) para o projeto 
ClearView. 

O Crystal Ball pode gerar mais do que um forecast durante uma simulação. Neste caso, você pode definir ambas as fórmulas para 
o lucro bruto e lucro líquido como células forecasts. 



3.1.5.1 O forecast - Lucro Bruto  
Primeiro, observe o conteúdo da célula para lucro bruto. 

1. Clique na célula C21. 

O conteúdo da célula aparece na barra de fórmulas perto do topo de sua planilha. Os conteúdos são C16*C19*C20. O Crystal 
Ball usa esta fórmula para calcular o lucro bruto multiplicando Pessoas Com Miopia Após Um Ano (C16) pela Penetração de 
Mercado (C19) pelo Lucro Por Consumidor (C20). 

Agora que você entendeu a fórmula do lucro bruto, você está pronto para definir a célula forecast para o lucro bruto. 

Para definir esta célula forecast: 

2. Escolha Define > Define Forecast.  

A caixa de diálogo Define Forecast aparece como mostrado na Figura 3–17. Você pode entrar com o nome para o forecast. 
Como a célula forecast célula tem um texto à esquerda dela na planilha, aquele texto aparece como um nome na caixa de diálogo 
por default.     

Figura 3–17 Caixa de diálogo Define Forecast —Lucro Bruto se Aprovado 

 
Use o nome forecast que aparece, ao invés de digitar um novo nome. 

Como a planilha do modelo envolve milhões de dólares, indique isto na caixa de diálogo. 

3. Digite Milhões no campo Units. 

4. Clique OK para retornar à planilha. 

3.1.5.2 O forecast Lucro Líquido  
Antes de definir a célula forecast com a fórmula para o lucro líquido, observe os conteúdos da célula para o lucro líquido: 

1. Clique na célula C23. 

Os conteúdos aparecem na barra de fórmulas acima da planilha. Os conteúdos são 

SE(C11,C21-C7,-C4-C5). 

A fórmula é traduzida como segue 

Se a FDA aprovar a droga (C11 é verdadeira), então calcule o lucro líquido subtraindo os custos totais (C7) do lucro bruto (C21). 
Entretanto, se a FDA não aprovar a droga, (C11 é falsa), então calcule o lucro líquido deduzindo ambos os custos de 
desenvolvimento (C4) e de testes (C5) incorridos até aquela data. 

Para definir a célula forecast para o lucro líquido: 

2. Escolha Define > Define Forecast.  

A caixa de diálogo Define Forecast aparece, como na Figura 3–18.     

 

 

 

 

 

 



Figura 3–18 A caixa de diálogo Define Forecast—Lucro Líquido 

 
Novamente, use o nome forecast que aparece no campo Forecast Name  e especifique milhões no campo Units. 

3. Digite Milhões no campo Units. 

4. Clique OK para retornar à planilha. 

Você definiu as células assumptions e forecast para a planilha Vision Research, e agora está pronto para executar a simulação. 

3.1.6 Executando a simulação 
Quando você executa uma simulação no Crystal Ball, você tem a liberdade de parar e daí continuar a simulação a qualquer 
momento. Os comandos Run, Stop, e Continue aparecem no menu ou no grupo da faixa de opções Run  no Excel ou no Painel 
de Controle do Crystal Ball quando você precisar deles. Por exemplo, quando você estiver executando uma simulação, o comando 
ou botão Stop [Simulation] aparece. Se você parar a simulação, o comando ou botão Continue Simulation  ocupa o seu lugar  
(no Excel 2003 ou anteriores). 

Os botões para estes comandos aparecem na barra de ferramentas do Crystal Ball e, uma vez tendo iniciado a execução da 
simulação, eles aparecem no Painel de Controle do Crystal Ball, descrito na Section 2.2.6, "Reset and single-step". 

Antes de você iniciar a simulação, especifique o número de trials e o valor da semente (seed) inicial de modo que sua simulação 
ficará parecida com os gráficos forecast deste tutorial. Veja o Crystal Ball User Manual para mais informação sobre as trials e 
valores sementes (seed). 

3.1.6.1 Configurando as Run Preferences 
Para especificar o número de trials e valor semente (seed): 

1. Escolha Run > Run Preferences > Trials.  

A caixa de diálogo Run Preferences Trials aparece. Para este exemplo, executaremos mais trials para obter resultados mais  
precisos de forecast.     

2. No campo Number of trials to run, digite 5000. 

3. Clique Sampling. 

4. Escolha Use same sequence of random numbers. 

5. No campo Initial seed value, digite 999. 

6. Note que existem duas escolhas no grupo Sampling methods: Monte Carlo e Latin Hypercube. Latin Hypercube é 
menos randômico e produz um alisamento, gráfico de resultados mais lisos. Por ora, de qualquer forma, escolha o default — 
Monte Carlo. 

7. Clique OK. 

3.1.6.2 Clique o botão Run 

Para rodar a simulação, clique Run.     

3.1.7 Interpretação dos resultados 

Agora que você rodou a simulação, você está pronto para interpretar os resultados forecast. 

O presidente da Vision Research deparou-se com uma decisão difícil: a companhia deverá jogar fora o projeto ClearView ou 
prosseguir o desenvolvimento e market desta nova droga revolucionária? 



Para examinar esta questão, você precisa observar os gráficos forecast. 

 

Nota: A janela do Crystal Ball está separada da janela Excel. Se a janela ou gráfico do Crystal Ball desaparecer da sua tela, elas 
ficam geralmente atrás da janela principal do Excel. Para trazê-las para frente, clique no ícone Crystal Ball na barra de tarefas do 
Windows ou pressione Alt-Tab e escolha Crystal Ball. 

 
Para mostrar os gráficos forecast  no Excel 2007, escolha Analyze > View Charts > Forecast Charts. 

 
3.1.7.1 Exame do gráfico forecast – lucro líquido 
Os gráficos forecast são as distribuições de frequências. Eles mostram o número ou freqüência de valores ocorrendo numa dada 
caixa ou intervalo de grupo e mostra como as freqüências são distribuídas. Na Figura 3–19, a  caixa que contém a maioria dos 
valores tem uma freqüência de cerca de 280. 

Figura 3–19 O forecast Lucro Líquido 

 
O Crystal Ball projeta (forecasts) o intervalo completo de resultados para o projeto Vision Research. Entretanto, os gráficos  
forecast não mostram os valores mais extremos (outliers). Aqui, o intervalo mostrado inclui valores de aproximadamente  –$15 
milhões até $38 milhões. 

O gráfico forecast mostra também o intervalo de certeza para o forecast. Por default,o intervalo de incerteza inclui todos os valores 
de menos infinito até mais infinito. 

O Crystal Ball compara o número de valores no intervalo de certeza com o número de valores no intervalo completo para calcular 
o nível de certeza. 

Os exemplos acima mostram um nível  de certeza de 100%, desde que o intervalo de certeza inicial inclui todos os valores 
possíveis. Lembre-se que o nível de certeza é uma aproximação, desde que uma simulação pode somente aproximar os elementos 
do mundo real. 

3.1.7.2 Determinação do nível de certeza do lucro líquido 
O presidente da  Vision Research quer saber quão certo a Vision Research poderá alcançar  um lucro e quais são as chances de um 
prejuízo. 

Para determinar o nível de certeza de um específico intervalo de valores: 

1. No gráfico forecast Lucro Líquido, digite 0 no campo mínimo do intervalo de certeza. 

Intervalo de Certainty 

Certainty grabbers 

Número de trials 
mostrado 

Número de trialsNúmero de trials

Número de trials 
mostrado 

Certainty grabbers 

Intervalo de Certainty 



2. Pressione Enter. 

O Crystal Ball move a presilha (grabber) de certeza esquerda para o valor do ponto de equilíbrio (break-even value) de $0.0 e 
recalcula o nível de certeza. 

Figura 3–20 Forecast Lucro Líquido —$0 mínimo 

 
 

Analisando o gráfico forecast Lucro Líquido novamente, você pode ver que o intervalo de valores entre as presilhas (grabbers) de 
certeza mostra um nível de certeza em torno de 79%. Isto significa que a Vision Research pode estar 79% certa de conseguir um 
lucro líquido. Você pode, portanto, calcular uma chance de 21% de sofrer um prejuízo líquido (100% menos 79%). 

Agora, o presidente da Vision Research gostaria de saber a certeza de atingir um lucro mínimo de $2.000.000. Com o Crystal Ball, 
você pode responder facilmente esta questão. 

1. Digite 2 no campo mínimo do intervalo de certeza. 

2. Pressione Enter. 

A Figura 3–21 mostra, o Crystal Ball move a presilha (grabber) de certeza esquerda para $2.0 e recalcula o nível de certeza. 
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Figura 3–21 Nível de certeza recalculado 

 
A Vision Research pode estar certa em cerca de 72% que atingirá um lucro líquido mínimo $2.000.000. 

A Vision Research está muito encorajada com os resultados do forecast. O presidente quer agora saber com que certeza a Vision 
Research poderá atingir um lucro mínimo de $4.000.000. Se o Crystal Ball mostrar que a Vision Research pode ficar no mínimo 
dois terços certa de um lucro líquido de $4.000.000, o presidente prontamente irá em frente com o projeto da ClearView. 

Novamente, o Crystal Ball pode facilmente responder esta questão: 

1. Digite 4 no campo mínimo do intervalo. 

2. Pressione Enter. 

O Crystal Ball move a presilha (grabber) esquerda para $4.0 e recalcula o nível de  certeza. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Figura 3–22 Forecast Lucro Líquido—$4.0 milhões mínimo 

 
O gráfico forecast Lucro Líquido na Figura 3–22 mostra um nível de certeza de quase 66%. Com virtualmente dois terço de 
certeza de um lucro mínimo de $4.000.000, a Vision Research decide ir adiante com o projeto ClearView e continua a desenvolver 
e comercializar esta nova droga revolucionária. 

Você pode trabalhar com o gráfico Lucro Bruto de maneira similar. 

3.1.7.3 Customizando os gráficos forecast 
Os gráficos do Crystal Ball são úteis para apresentação dos resultados como também para analisá-los. Uma variedade de 
preferências de gráficos estão disponíveis para mostrar diferentes exibições de gráficos, tipos , cores e muito mais. 

Para mostrar as chart preferences, escolha Preferences > Chart na janela de gráfico forecast. Você pode clicar o botão Help para 
aprender mais sobre as preferências em cada guia. 

Você pode também usar teclas de atalho para customizar a aparência dos gráficos sem usar a caixa de diálogo Chart Preferences. 

Selecione um gráfico forecast e tente estas teclas de atalho agora: 

■ Pressione Ctrl-t para circular pelos tipos de gráficos (área, linha, e coluna). 

■ Pressione Ctrl-d para mudar as exibições dos gráficos (frequência, frequência acumulada, frequência acumulada reversa). 

■ Pressione Ctrl-m para circular por uma série de marcadores que mostram a média e outras medidas de tendência central. 

■ Pressione Ctrl-p para circular por uma série de marcadores de percentís. 

■ Pressione Ctrl-b para mudar a densidade do gráfico variando o número de caixas. 

■ Pressione Ctrl-3 para mostrar o gráfico em 3D. 

■ Arraste as margens da janela gráfico até as proporções e tamanhos se adequarem aos seus planos de apresentação. 

Por exemplo, Figura 3–23 mostra o forecast do lucro bruto da ClearView apresentado como um gráfico de área 3-D 

Com um marcador de média, esticado para mostrar mais detalhes no eixo-x. O gráfico está também configurado para transparência 
de 50%. Os campos de certeza foram configurados para mostrarem que a certeza de um lucro bruto maior que $32 milhões é em 
torno de 78%. 

 



 

Figura 3–23 Grafico Customizado do lucro bruto 

 
Você pode escolher Edit > Copy Chart na barra de menu do gráfico para copiar um gráfico para o clipboard para depois colar no 
Excel ou em outra aplicação. A Figura 3–24 mostra o gráfico do lucro bruto da ClearView colado num slide do Microsoft 
PowerPoint. 

Figura 3–24 Gráfico do Lucro Bruto colado no PowerPoint 

 



3.1.8 Feche o Crystal Ball 
Para fechar o Crystal Ball, saia do Excel. 

3.1.9 Sumário 
Neste tutorial, você iniciou o Crystal Ball, abriu o tutorial modelo exemplo, definiu assumptions e forecasts, executou a  
simulação, e examinou e customizou gráficos forecast. Experimentando os valores de certeza, você explorou umas poucas 
questões que os executivos da Vision Research poderiam fazer quando eles analisaram os resultados da simulação. 

3.2 Aprendendo mais 
Quando você ler o Crystal Ball User Manual, você aprenderá mais acerca da customização de gráficos forecast, criação de outras 
espécies de gráficos, interpretação das estatísticas descritivas, e impressão de relatórios compreensíveis para qualquer simulação. 
O Crystal Ball fornece estas características de modo que você possa quantificar o risco inerente nas suas assumptions. 

O Crystal Ball mantém suas definições de assumption e forecast (mas não os valores forecast) com a planilha. Quando você salvar 
a sua planilha, as definições são salvas com ela. Para aprender acerca de salvar e recuperação dos resultados forecast, ver o Crystal 
Ball User Manual. 

 


